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IMAGENEX MODEL 872
“YELLOWFIN”
SIDESCAN SONAR

APPLICATIONS: FEATURES:

Underwater Archaeology
Sunken Timber Recovery
Search & Recovery 300 m depth rating

Surveying Up to 400 m (1300’) total coverage

e Triple frequency
[ ]
[ ]
[ ]

Law Enforcement Work e 23 m (75’) tow cable included
[ ]
[ ]
[ ]
[ ]

High resolution 1000 data points per side

Scientific Research LAN compatible
Environmental Survey Built-in track plotter
Built-in internal GPS receiver
Record to .XTF in real-time

The Imagenex Model 872 “YellowFin” is a full- -
featured dual channel, high resolution, sidescan sonar.
The YellowFin is an affordable, very user friendly system
that incorporates a high speed Ethernet connection to

your Windows™ based laptop or desktop PC. Integrated \-a

power and a built-in differential-ready GPS receiver 8 B \

complete this fantastic system. Zoom windows are —
;n,ih' s—

available for target investigation without interrupting real- 1 — oL
time data acquisition. Data is displayed in real-time, with b’ /

or without speed correction, in 9 user selectable colour

tables. —-—
UNDERWATER HARDWARE
SPECIFICATIONS:
FREQUENCY 260 kHz / 330 kHz / 800 kHz nominal
TRANSDUCER One transducer per side, tilted down 20°
TRANSDUCER BEAM WIDTH 260 kHz: 2.2° x 75°

330 kHz: 1.8° x 60°

800 kHz: 0.7° x 30°
RANGE RESOLUTION Range scale + 1000
MAX. OPERATING DEPTH 300 m (~1000"
MAX. CABLE LENGTH 600 m (~2000")
INTERFACE Analog telemetry
CONNECTOR Wet mateable (Subconn MCBH4M-AS)
POWER SUPPLY 40 — 55 VDC at less than 3 Watts,

supplied from Surface Interface Box
DIMENSIONS 114 mm (4.5") diameter x 833 mm (32.8") length
WEIGHT: In Air 5.4 kg (12 Ibs)

not including ballast
In Water 1.8 kg ( 4 Ibs)

BALLAST Standard diver belt weights (readily available at dive shops)
MATERIALS Polyurethane & 6061-T6 Aluminum
FINISH Hard anodized
Specifications subject to Copyright © 2004 - 2019

change without notice Www.imagenex.com Imagenex Technology Corp.




SURFACE INTERFACE BOX
HARDWARE SPECIFICATIONS

INTERFACE TO PC

10 Mbps Ethernet

INTERFACE TO SONAR HEAD

FSK analog telemetry

CABLE CONNECTOR

5-pin MS (female)

SONAR HEAD
POWER SUPPLY OUTPUT

48 VDC

DIFFERENTIAL CAPABLE GPS

Built-in

DIMENSIONS

31 cm (12.2") length x 26 cm (10.2") width x
8.7 cm (3.4”) height

WEIGHT 0.9 kg (2 1bs)
MATERIALS Aluminum
FINISH Powder Coated

POWER REQUIREMENT

110/220 VAC 50/ 60 Hz, 0.1 Amp

SOFTWARE
SPECIFICATIONS:

YellowFin.exe

WINDOWS™ OPERATING SYSTEM

Windows™ XP, Vista, 7, 8, 10

Z0O0OM MODES

1x, 2%, 3%, 4x, and 5x dynamically moveable

RANGE SCALES

10m,20m, 30 m, 40 m, 50 m, 60 m, 80 m, 100 m,
125 m, 150 m, and 200 m

FILE FORMAT

(filename).872, (filename). XTF

GPS INPUT (4800, N, 8, 1)
NMEA 0183 FORMATS:

GLL and VTG; GGA and VTG; RMC

RECOMMENDED
MINIMUM COMPUTER
REQUIREMENTS:

800 MHz Pentium 3

256 MB RAM

2 GB Hard Disk

1024 x 768 x 256 colour graphics

1.76in
75in 44.6mm
19.1mm

8.00in
203.2mm

=

i [
3.50in 18.00in 12.50in
[88.9mm | [457.2mm ] [817.5mm]| 7
34.00in
[863.6mm |

ORDERING
INFORMATION:
300 m unit w /23 m tow cable Standard 872-000-150
Surface Interface Box Standard 872-000-001
60 m (200") Sidescan tow cable Option -021
100 m (330’) Sidescan tow cable Option -033
Product and company names listed are trademarks or trade names of their respective companies.
872 YellowFin 2
445-029 www.imagenex.com




Setting up your YellowFin® for use

Unpack your YellowFin and check for the following parts:

Nose

Aluminum Tube

Tail

Ballast Plate

Surface Processor
Kevlar strength tow cable
User's Guide

Sonar CD

GPS Antenna

10. Power cord

11. Serial cable

12.  Ethernet cable

13. U/W connector

14. MS connector

15.  Plastic retaining rods
16. Cable ties

17.  Shackle

©CoNouh,~whE

Connecting the cable to the YellowFin

1. Apply a small amount of silicon grease to the rubber part of the male
pins on the electronics bulkhead.
2. Check the orientation of the two connector halves and carefully but

firmly push them together. Slide the locking sleeve into position and
screw into place (Fig. 1).

3. Install the tail back into the aluminum tube, taking care to fit the cable
into the slot provided. Thread the plastic retaining rod into the groove
completely (Fig. 2).

4, Attach the cable thimble to the aluminum tube using the shackle
provided (Fig. 3).

Fig. 1 Fig. 2 Fig. 3



Installing Ballast

1. Extract the ballast plate from inside the aluminum tube (Fig. 4). Make
a note of the orientation.

2. The YellowFin is designed to use conventional 3 Ib lead diving weights
as ballast* (Fig. 5).

3. Add at least 15 — 20 Ibs of ballast as far forward and as low as

possible, securing the weights with cable ties. Adding more weight will
allow the YellowFin to be towed at a greater depth.

4. Slide the ballast plate back into the aluminum tube, install the nose
cone, and thread the plastic retaining rod into the groove completely

(Fig. 6).

*Ballast weights are not included

Fig. 4 Fig. 5 Fig. 6

Trimming the YellowFin by adjusting the tow shackle position

Immerse the YellowFin in still water, and adjust the shackle position so that the
YellowFin lies parallel to the water surface (ensure that no air is trapped in the
aluminum tube, as this will give a false indication). If the YellowFin wanders
while being towed, adjust the shackle position so that the towfish is slightly nose
heavy.



Ballasting and Cable Routing
of the Imagenex Model 872 “YellowFin”

Afix Tow Point so that the Nose is

Plate Rubber ~1"Lower in the Water than Tail

Bumpers fit in
Notch of End Cap

Ensure that Weight

(oooooooooooooooo}

/

@
Mount Lead Weights so 7-8lb
that Majority on Bottom Lead Weight in Nose Cone

Suggested Cable Routing
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WARNING: AVOID IMPACT TO
SENSITIVE TRANSDUCER AREA
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What's New in YellowFin 2.0

Numerous updates and features have been added to YellowFin version 2.0. Some of the major features
are listed below.

NEW e Added Event Marker capability to allow annotation of data files (See Section 3.8 on
page 12).

NEW + Added GPS satellite information to indicate how many satellites are detected (See
Section 5.6 on page 23).

NEW » Added Bitmap View display mode for rapid file playback (See Section 3.2 on page 6 ).

NEW » Added reverse file playback mode for enhanced file playback control (See Section 3.2
on page 6 ).
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1.0 System Description

The Imagenex Model 872 "YellowFin" is a full-featured dual channel, high-resolution, side-scan sonar. The
YellowFin is an affordable, user friendly system that incorporates a high speed Ethernet connection to
your Windows™ based laptop or desktop PC. Integrated power and an optional differential-ready GPS
receiver complete this fantastic system. Zoom windows are available for target investigation without
interrupting real-time data acquisition. Data is displayed in real-time, with or without speed correction, in 9
user selectable color tables.

2.0 Getting Started:

After you are sure you have correctly wired the system, turn the power on to the surface processor and

your computer. After the operating system started, double click the program icon J on your desktop
screen to launch the YellowFin program. You can exit this application by clicking the close window button
at the upper right corner of the screen or use the menu command

“File->EXxit".

YellowFin.exe is a Windows program that controls, displays and records data from the YellowFin Sidescan
Sonar System. The program uses a high speed Ethernet connection (10Mbps) to communicate with the
Model 872 sonar processing unit.

This document describes how to use the commands provided by the YellowFin program to control the
Model 872 sonar unit and how to view the data.

2.1 Screen Layout

The default screen layout of YellowFin.exe program provides a vertically displayed sonar image with a
user menu on top and a toolbar at left, as well as a status bar at the bottom in real-time data acquisition
operation. If you run YellowFin.exe for file playback, there will be a Playback bar shown under the user
menu. You can resize the sonar image display window and hide the toolbar or status bar by using the
menu command: “View->Tool Bar” or “View->Status Bar” or

“View->Playback Bar".

2.2 Operations:

When you start running the YellowFin.exe program, it first prompts you with a dialog box asking if you
want to run it in real-time sonar data acquisition mode or run file playback. If you want to run real-time
sonar data, please click the “YES” button. The program will try to connect to the sonar head using the
specified IP address. If you only want to playback a file, please click the “NO” button and the program will
not connect to the sonar head. This also saves time in case there is no Ethernet connection available.

Page 1 of 39
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2.3 Interrogating the sonar unit:

Real-time sonar data interrogation needs communication between the YellowFin program and the sonar
unit. The communication protocol is based on high speed Ethernet. The YellowFin.exe program uses
another thread to send operation commands to the sonar head and then receive sonar data returns.

You can save real-time data to a file by using the menu command “File->Record Data” or clicking the
Toolbar button for post process or later inspection. Use the menu command “File->Stop Recording”

or clicking the Toolbar button @ to quit saving data.

2.4 File playback:

You can also use the YellowFin program to playback data that has been recorded to a file (with file
extension ".872" or ".xtf").

To open a .872 or .xtf data file to playback, use the menu command “File->Open a file” or click the Toolbar

button . When the program is running with file playback, the frame window will show a File Playback
dialogue bar under the main menu. You can drag and dock it to a convenient place on the screen. This
dialogue bar lets you control the playback speed and playback file position. See the section “File Playback
Progress Dialog Bar” section for details.

Once you open a sonar data file to playback, the operation of real-time sonar data acquisition will stop.
You can open only one data file to play back at a time. But you can open another data file to playback
during file playback, the previously opened file will be closed.

You can once again change the operation to real-time data interrogation by using the menu command

“File->Connect...”, “Communication->Reconnect” or click the Toolbar button . When the system
starts to acquire data from sonar head, opened data file will be closed. If the Ethernet connection is lost or
failed, you can use the menu command

“Communication->Reconnect” to reconnect.

Note: There are several things that can cause lost or failed connection. One is that the user
turned the power to the surface processor off. The other is that the Ethernet connection is not

configured correctly.

The YellowFin program provides several convenient ways (menu commands, dialog boxes, and toolbar
commands) to control the sonar unit’'s operations, operating parameters, and data display windows.

Page 2 of 39
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2.5 Sonar Image Manipulation

The YellowFin program uses a bitmap image with the size of the display screen to display the sonar
image. When the program receives one sonar shot data either from real-time or playback, the data will be
displayed at the top line of the image and the previous shots will be shifted down.

You can use the command “Zoom In” or command “Zoom Out” to zoom in or out the image and use the
command “Hold” to pause the image display. When you zoom in, the image size will be larger than the
display window size. Thus, some portion of the image will be hidden beyond the size of the display
window. If you want to see the hidden part of the image, you can drag the image to let that part fall in the
display window. You can move the image by holding down the left mouse button and dragging (moving)
the image. When you release the left mouse button, the image dragging operation will stop. Use the
command “Restore Image” to restore the sonar image to its original size and position.

Note: If the hold command is activated during file record, data is still recorded although the
display does not move. This allows the user to inspect an area of interest without losing any
data

Page 3 of 39




Imagenex Technology Corp. ©2009 Model 872 ver 2.0 User's Manual

3.0 MAIN MENU

File Wiew Color Table Settings Communication  Measure GPS Opkions  Ewents  Help

Figure 1 - YellowFin Menus

3.1 File menu commands

The File menu offers the following commands:

Connect to Sonar
Head...

Use this command to establish an Ethernet connection between the sonar
head and the control computer. If the connection is established successfully,
the YellowFin program will start to interrogate the sonar head for data in real-
time. This command is very useful when you change the operation from file
playback to real-time data acquisition. If this command is disabled, which
means the program is operating in real-time data acquisition mode not in file
playback mode. If the connection has failed, after a minute or so, the program
will display an error message “No Connection!”. You can check the wiring and
reconnect the network again by using the “Communications->Reconnect”
command.

Shortcuts
Toolbar Button:
Keys: Ctrl+N

Playback...

Use this command to open a previously recorded YellowFin sonar data file
(with the file extension .872 or .xtf) to play back. The YellowFin program
displays the File Open dialog box so you can choose which file you want to
open.

Shortcuts

Toolbar Button:

Keys: Ctrl+O

Record Data or
Copy Start...

Use this command to save real-time sonar data to a file or copy part of a file to
another one during playback. YellowFin displays the Save As dialog box so you
can name your file. The file name can be any characters and digits combined.
YellowFin will automatically add file name extension .872 or .xtf to your file
name, depending on what file format you choose, so you don't have to type the
file extension. Then YellowFin will continue interrogating the sonar unit for data
and at the same time recording those data to your named file.

You can use the Stop Recording command to quit recording data. YellowFin
then closes the named file.

During file playback, “Record Data” is replaced with “Copy Start”. This allows
you to copy data from one file to a separate file.

Shortcuts

Toolbar:

Keys: Ctrl+S
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Stop Recording or
Copy Stop

Use this command to stop recording or copying sonar data to a file. YellowFin
will close the file. You can use the “Playback...” command to open it for
playback.

Shortcuts

Toolbar: @

Keys: Ctrl+Z

Settings Change
Alarm
New

Use this command to play a sound when a setting changes during file playback
Supported settings are: Range, Mode, and End of File

Save Screen

Use this command to save the whole sonar image to a named image file. The
image file formats can be ".bmp", ".jpg", ".png", ".tiff", and ".gif".

Save Selected

Use this command to save part of the sonar image to a named image file. The
image file formats can be .bmp, jpg, .png, .tiff, and .gif.

Note: Before you use this command, you should use toolbar “select”
command to select an image area. Put the display on hold, then push the

“select” m button and the program is in the select mode. Hold down the left
button of your mouse at the start point and drag the mouse to the end point of
your interested area and then release the button. The program will draw the
selected area with dashed lines. If you are not satisfied about this selected
area, you can select again and your first selected area will be discarded. After
you selected an area, you can use this command to save it to an image file.

You should click the “select” m button again to release this select mode so
the program can respond to other commands.

If there is no selected area available, this command will be disabled.

Exit

Use this command to terminate your YellowFin program. The system will save
your display layout, sonar settings, and GPS configuration to a text file called
YellowFin.ini. Next time you start the program, the system will load these
settings from this file.

Mouse: Double-click the application's Control menu button.

¢ YellowFin -

Elle Wiew Calor

Frogress [ F——

Keys: ALT+F4
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3.2 View menu commands

The View menu offers the following commands:

Clear Screen

Use this command to clear the image in display window.

Shortcuts

Toolbar Button:

Keys: ¢

Grid

Use this command to display and hide the vertical grid line.

Grid Text Size

Use this command to change the text size used as range text marks displayed
at the bottom of the display window and measurement text marks.

Hold Use this command to pause the image display. Toggle this command to pause
or continue the image display. Note that this holds the display only. Data will
still be recorded to the current file.

Shortcuts
Toolbar Button: @‘
Keys: h

Bitmap View Use this command to display the sonar data one screen at a time. Rather than
the typical waterfall display, this display uses the standard Windows scroll bar

NEW to control the file position. Scrolling the bar up will advance the file forward,

while scrolling the bar down will advance the file in reverse.

Reverse Playback

NEW

Use this command to play the data file in reverse.

Zoom In

Use this command to zoom in the image. This command centers the zoom
area on the mouse position. The zoom factors are 1x1, 2x2, 3x3, 4x4, and 5x5.

Shortcuts

Toolbar Button:

Keys: z

Zoom Out

Use this command to zoom out the image.
Shortcuts

Toolbar Button:

Keys: z

Restore Image

Use this command to restore the sonar image to its original size and position.
When you move the image by clicking and dragging the image, and then zoom
infout on the image, the image may not be seen in the viewing window. Use
this command to restore the image to its original size and position.

Shortcuts

Toolbar Button:

Keys: r
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Port Only Use this command to display only the Port channel. Note that, if recording a
file, both channels are always recorded regardless of the display view.

Sthd Only Use this command to display only the Starboard channel. Note that, if recording
a file, both channels are always recorded regardless of the display view.

Both Sides Use this command to display both Port and Starboard channels.

Status bar Use this command to display and hide the status bar, which shows some of the
important information in YellowFin, such as operating range, data gain, etc. A
check mark appears next to the menu item when the Status bar is displayed.

Toolbar Use this command to display and hide the toolbar, which includes buttons for

some of the most common commands in YellowFin, such as playback and
measurement commands, such as measure target height and measure
distance. A check mark appears next to the menu item when the Toolbar is
displayed.

File Playback bar

Use this command to display and hide the File Playback Progress dialog bar ,
which includes playback speed spin buttons and file playback progress display.
A check mark appears next to the menu item when the File Playback bar is
displayed.

Show Range

Use this command to show or hide the range display in the upper left corner of
the image.

Show Mark Shadow

Use this command to show or hide the black background for the text marker
display.

Units

Use this command to choose which display units you like to use. Range and
distance can be displayed in meters (Metric) or feet (Imperial).

Vertical Blending

Use this command to blend data from adjacent pings. This technique uses the
ships’ speed to determine bottom coverage, and is therefore only valid if the
ships’ speed is not zero.

Color Indicator

Use this command to display and hide the color table indicator bar, which
displays the color table used to represent echo strength. If enabled, this color
table bar is displayed on the right side of the sonar image display window. The
upper level colors represent higher echo strength, and lower level colors
represent lower echo strength. A check mark appears next to the menu item
when color table indicator bar is displayed.

Use the menu command ColorTable to choose your preferred colors to display
the sonar image.

Page 7 of 39
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3.3 Color Table Menu Commands

The Color Table menu is used to change the sonar data colour palettes for the sonar images.

YellowFin uses colours (called a colour table) to represent echo data strength (amplitude). For example:
Normal High intensity color table used for mapping the echo data amplitude to 256 colors ranging from

Black (low strength level) though blue, green, orange yellow white and red (highest strength level).

The Color Table menu offers the following commands:

Normal High Standard colour table used for mapping the echo data amplitude to 256
colours ranging from Black (low level), through Blue, Green, Orange, Yellow,
White and Red (highest level).

Normal Low Same colours as Norm Hi, but uses a lower colour intensity.

Green 256 shades of green.

Grey 256 shades of gray (White on Black).

Reverse Grey 256 shades of gray (Black on White).

Brown/Yellow 256 mixed shades of brown and yellow.

Green/Blue 256 mixed shades of green and blue.

Green/Yellow 256 mixed shades of green and yellow.

Blue 256 shades of blue.

3.4 Settings Menu Commands

The Settings menu offers the following commands:

Sonar Settings Display the Sonar Settings Dialog Box. If the dialog box is visible,
this command will be disabled.

See Sonar Settings Dialog Box and Diagnostics Dialog Box for details about sonar settings and
diagnostic items.

3.5 Communication Menu Commands

The Communication menu offers the following commands:

Reconnect Use this command to re-establish the connection between the PC
and the sonar head. This command is different from

“File->Connect to Sonar Head...” which is used to change operation
from file playback to real-time acquisition. The “Reconnect”
command is used to reconnect the Ethernet link in real-time
acquisition mode.

Diagnostics Display the Diagnostics Dialog Box. If the dialog box is visible, this
command will be disabled.
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3.6 Measure Menu Commands

The Measure menu offers the following commands:

Draw ‘+' Mark

This command is used to draw a mark (+) on the screen at the current mouse
position by first clicking the command and then clicking the target that you
want to draw the mark on. Repeat the operation to draw more marks.

Shortcuts

Toolbar Button: B

Measure Target Height

This command is used to measure the approximate height off the bottom of a
target (assuming a flat bottom). When selected, the cursor will display ‘Click
on the Target . At this point, position the target cursor on the target of interest
and press the left mouse button. A Horizontal rubber-banded line is drawn
from the cursor position to the beginning of the transmit pulse with the
message ‘Click on First (Bottom) Return . Position the cursor so that the
end of the rubber-banded line is at the beginning of the bottom return (the end
of the water column) and press the left mouse button again. The message
‘Click on Shadow Start ' is now displayed. Position the cursor at the
beginning of the shadow that the target has cast and press the left mouse
button. The message

‘Click on Shadow End — H = ???M ' is displayed. Move the cursor to the end
of the shadow to display the height measurement. Press the left mouse button
again to begin a new measurement.

Shortcuts

Toolbar Button: @

Measure Range

Measures horizontal (slant) range between the sonar and the target or current
mouse position. Draws a horizontal line on the screen, with the range shown.

This command is used to measure the range from the center of the sonar to a
target. When you first click on the command, the YellowFin program will draw
a temporary horizontal line from the center of the sonar to the current mouse
position. Move the mouse to a selected target and the temporary horizontal
line moves with the mouse. Click on the target, the YellowFin.exe program
will draw that horizontal line permanently. The Range mark "xxx.x m” or “Xxx.x
ft” is shown at the end of the line.

Shortcuts

Toolbar Button: @
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Measure Distance

Measures the distance between two targets. Draws a line on screen, with
the distance shown.

This command is used to measure the distance between two targets by
clicking on one target and moving the cursor to the other target and clicking
on it in the display window. This command draws a line connecting these two
selected targets, a start symbol (+) and a stop symbol (+). The distance
between these two targets is shown as “xxx.x m” or “xxx.x ft” at the end of the
line.

Note: The ship (or sensor) speed is heeded to measure along track distance
(along the ship heading direction) correctly.

Shortcuts

Toolbar Button:

Clear Lines/Marks

Deletes all lines and symbols and text marks drawn on the screen.

Shortcuts

Toolbar Button:

Note: Since the sonar image is displayed as a moving picture, it is highly recommended that you
place the display on hold before doing any measurements and clear those lines and marks

on hold.

before you release the hold status. If recording to a file, data will still be saved while the display is
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3.7 GPS Options menu commands

The Communication menu offers the following commands:

Show GPS Track Plotter

Use this command to open another window, which displays the
sonar (or the ship) track plotted according to the GPS provided
latitude and longitude information.

GPS Comm Port Settings

Configure the serial communication port for GPS data
acquisition. The baud rate, stop bits, parity, etc. should match
those of the GPS receiver.

Speed Correction

Use this command to enable or disable Speed Correction.

The ship’s (or sensor) speed information is obtained from the
system GPS receiver. The YellowFin program will use the ship’s
speed and slant range information to adjust the aspect ratio of
the sonar image.

Convert UTC to Local Time

Use this command to display the UTC time in local time
coordinates.

Synchronize with GPS Time

Use this command to adjust the computer’s time to match the
GPS time.

Erase GPS Tracks

Use this command to clear the GPS track plotter window.

New

Zoom in Use this command to zoom in the GPS track plot window using
the following grid divisions: 10m, 20m, 50m, 100m, 200m, 500m,
1000m.
Shortcuts
Keys: +, =

Zoom out Use this command to zoom out the GPS track plot window using

the following grid divisions: 10m, 20m, 50m, 100m, 200m, 500m,
1000m.

Shortcuts

Keys: -
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3.8 Events menu commands ( New)

When recording real-time data to a file, events can be recorded at the same time.

Note: The “.AN” annotation file is linked to the “.872" data file. Do not rename one file without
renaming the other. Do not edit the “.AN” file. Failure to comply will result in errors, and/or lost
| event markers.

The Events menu offers the following commands:

Enable Event Input Use this command to enable / disable event recording. This
New menu item is only active during file playback or while real-time
data is being recorded.

Hide Event Marker Use this command to enable / disable event marker display on
New the screen. This menu item is only active during file playback or
while real-time data is being recorded.

Auto Event Info PopUp Use this command to display the Event Information Dialog Box.
New Descriptions about this event may be entered in the annotation
area. This menu item is only active during file playback or while
real-time data is being recorded.

Event Review/Edit Use this command to review, edit, or delete an event/annotation.
New This menu item is only active during file playback or while real-
time data is being recorded.

Real-Time

To enable event recording, click the menu item "Events->Enable Event Input”, then “double click” the
target of interest. The Event Information Dialog Box will appear. Descriptions about this event may be
entered in the annotation area. The event information will be written to an annotation file (using the same

file name as the data file but with a “.AN” as the file extension), and an event mark . will be drawn at
the cursor position. For each additional Event Mark, the number inside the circle will increase. Click
"Cancel " to discard this event. Select "Events->Hide Event Marks" to hide the event marks.

File Playback
If there is an annotation file accompanied with this playback file, the event marks will be drawn on the
sonar image when the file reaches the point where the event was recorded.

More events may be added the same way as described in the real-time event recording method. Added

events will be written to the same annotation file. If there is no annotation file for this data file, the program
will create an annotation file and write the events info to it.
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Event Information

(X

Event Mumber: JID

Latitude: {49.17.5853 N

Longitude: [122 531175 W

Annotation

Ping Mumber: 10163
Date: |[26-0CT-2004
Time: |14:18:49

sample event marker

QK

Cancel

Figure 2 - Event Information Entry Dialog Box

Menu items "Events->Auto Event Info PopUp" and "Events->Event Preview/Edit" are used for file
playback. When you enable "Auto Event Info PopUp", an event info dialog box will appear when an event

marker occurs.

Event Information

&

Event Mumber: JID

Latitude: {49.17.5853 N

Longitude: [122 531175 W

Annotation

Ping Mumber: 10163
Date: |[26-0CT-2004
Time: |14:18:49

Sample event marker

QK

Cancel

Figure 3 - Event Information Dialog Box

By selecting "Events->Event Review/Edit", the descriptions of the events can be edited or deleted.
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Event Information

(X

Event Number: |0 Ping Number: |10163
Latitude: {49.17.5853 N Date: [26-0CT-2004
Longitude: {122 531175 W Time: [14:18:49
Arp e PREYV NEXT | EDIT ‘ DELETE
Sample event marker Ok
Cancel

Figure 4 - Event Information Preview / Edit Dialog Box

[ Note: The Latitude/Longitude used for the event is the GPS antenna position for the selected

ping (i.e. offsets to the target are not calculated).
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3.9 Help menu commands

The Help menu offers assistance with this application:

Beam Coverage

Use this command to run the Sidescan beam coverage program which gives a
graphical depiction of the area covered by the acoustic signal in different modes.

About YellowFin

Use this command to display the copyright notice and version number of your
copy of YellowFin as well as contact information.

Toolbar Button:
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4.0 Toolbars and File Playback Progress Dialog Bar
4.1 Main Toolbar

CEHRRRSSls0aak Wt SERT 2

Figure 5 - Main Toolbar

The main toolbar is displayed at the left of the application window. The toolbar provides quick mouse
access to many tools used in the YellowFin program. To hide or display the Toolbar, choose Toolbar from
the View menu.

Click

ez

! (= (o [] [

FEEEERPOEREERNEEE

To
Connect to sonar head.

Open an existing data file to play back.
Save real-time acquired sonar data to a file or copy playback data to another file.
Stop saving real-time data or stop copying playback data.

Increase operating range by one level.

Range: 10m, 20m, 30m, 40m, 50m, 60m, 80m, 100m, 125m, 150m, and 200m for low
and medium frequency.

Range: 10m, 20m, 30m, 40m, and 50m for high frequency

Decrease operating range by one level.

Increase data (display) gain by 1% (0~100%).

Decrease data (display) gain by 1% (0~100%).

Clear the screen.

Toggle this command to pause or continue the image display.
Zoom in. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5
Zoom out. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5
Select an image rectangle area to save to an image file.
Draw a mark (+) on the screen at the current mouse position.
Measure target height.

Measure distance between two targets.

Measure slant range from the center of the sonar to the target.
Deletes all lines and marks drawn on the screen.

Restore image to its original size (1x1) and position.

Show the about dialog box displaying the copyright notice and version number of your copy of
YellowFin as well as contact information.
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4.2 File Playback Progress Dialog Bar

File Progress |~ . . ., , WHENENE ~{ Play Back Speed
Figure 6 - File Playback Progress Bar
File Progress A slider bar with a pointer showing file playback position. Dragging the pointer to a

new position will cause the file playback to start at that position. The slider range
represents the file size. Note: You should always drag the pointer to a proper file
playback position and avoid clicking on the edge of the slider bar, since that will
cause the pointer stop moving as the file playback goes along. In that case, the
pointer position will not reflect the file playback position correctly. You can drag
the pointer once again to make the pointer move correctly.

Play Back Speed Pressing the spin button up or down will change the playback speed faster or
slower. The speed change will show in the adjacent progress bar.
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5.1 Connection Dialog Box
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Connection

IF address:

Try 1o connect 7

Click "vrES" for reaHime data acquisition
and click "NO" for file playback

192.168.0.2

TES

M

Figure 7 - Connection Dialog Box

This dialog box will appear when you start your YellowFin program. If you are ready for real-time data
acquisition, click the “YES” button. The program will connect to the sonar head via an Ethernet link. If you
only want to playback data files, please click “No” and the program will conveniently display the “Open
Data File” dialog box for you to choose a data file to playback. Please do not change the IP address as the
sonar address is statically assigned from the factory. For more information, please refer to the “YellowFin
Ethernet Setup Guide” available from Imagenex Technology Corp.
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5.2 Open Data File Dialog Box

The following options allow you to specify which file to open:

File Name Type or select the filename you want to open. This box lists files with the
extension you select in the Files of type box.

Files of type Select the type of file you want to open: The supported file extensions are “.872"
or “.xtf". if opening a sonar data file. The file with file extension “.872" is the
standard YellowFin recorded file format. YellowFin.exe can playback files with file
extension “.xtf” (Triton Extended File Format) ONLY if the “.xtf” file is recorded by
the YellowFin program.

Drives Select the drive in which the YellowFin control software stores the file that you
want to open.

Directories Select the directory in which the YellowFin control software stores the file that you
want to open.

Network... Choose this button to connect to a network location where the data file resides.

5.3 Save YellowFin Data File Dialog Box

The following options allow you to specify the name and location of the file you're about to save sonar data

into:
File Name Type a new filename or select an existing file name to save sonar data into that
named file.
Drives Select the drive in which you want to store the document.
Directories Select the directory in which you want to store the document.
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5.4 Sonar Settings Dialog Box

Settings
Range: Gain: Freguency:
Bm - [20 ] JLow ~
Port (dB) Gain Balance Sthd (dB)

-0.0 _; 0.0
Default

Figure 8 - Sonar Settings Dialog Box

The following options allow you to select sonar settings. These are the main parameters:

Range

Select the acoustic operating range.
Options:
Low Frequency: 10m, 20m, 30m, 40m, 50m, 60m, 80m, 100m,
150m, and 200m.

Medium Frequency: 10m, 20m, 30m, 40m, 50m, 60m, 80m, 100m,
150m, and 200m.

High Frequency:  10m, 20m, 30m, 40m, 50m

Data Gain

(Display Gain) Choose a Data Gain you want (from 0 to 100%). Data Gain is used
to increase or decrease the intensity (color levels) of the sonar image.

Mode/Freq

There are three frequencies to choose from: low, medium and high.

Gain Balance

Gain balance is used to adjust the balance of the Port/Starboard image. Drag the
gain balance slider bar to change the gain balance, which can be adjusted from
-3dB to +3dB. The “Port (dB)” and “Sthd (dB)"edit boxes are only used for display
purposes.
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5.5 Diagnostics Dialog Box

Diagnostics %
Side Scan Sonar
Header: J—
Serial Stat: [0
Run Type: ]nfa—
Mode/Freq: W
Range Index: g
Range: JB_Om—
Data Gain: J15—
Gain Balance: %0—
Link Commd:  jn/a
PRF: oo
Sync Mes: [oo  [o000

(0000|0000 |0000

R-Type [0000 [0 Stop

Figure 9 - Diagnostics Dialog Box

Model 872 ver 2.0 User’'s Manual

The Diagnostics Dialog Box is used to display important system variables. This dialog box is very useful
when trouble shooting the system in real-time. In file playback, certain system variables such as Header,
Serial Stat, and Run-Type etc. are not available to display since they are not recorded into the data file.

Header Sent by the sonar head (wet end) to tell the processor what kind of data format it
sent, IGX for YellowFin sonar data.

Serial Stat Indicates if the communication between sonar system and processor is normal
(Ox40 or 0x42) or not (other than 0x40 or 0x42).

Run-Type Sent by the sonar head (wet end) to tell the YellowFin program what command

the sonar is responding.

: standard sonar shot
: set Mode/Freq

: set Range

: set Gain Balance

WNEFLO

Mode/Freq : Low frequency
: Medium frequency

: High frequency

N = O
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Range Index

Current YellowFin sonar operating range index.
5: 10m
6: 20m
7: 30m
8: 40m
9: 50m
10: 60m
11: 80m
12: 100m
13: 125m
14:150m
15: 200m

Range

Current YellowFin sonar operating range.

Data Gain

Current YellowFin sonar operating Data Gain.

Gain Balance

Current YellowFin sonar operating Gain Balance.

Link Command

Sent by the YellowFin program to sonar head indicating the operating parameters
are changed by the user.

0: standard sonar shot
1: set Mode/Freq

2: set Range

3: set Gain Balance

PRF

Milliseconds elapsed between two consecutive interrogations of the sonar head.
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5.6 GPS Serial Port Configuration Dialog Box

The GPS Serial Port Configuration Dialog Box is used to configure the GPS serial communications on

your PC.

Com Port Specifies the communication serial port to be used.

Baud Rate Specifies the baud rate at which the GPS communications operates. The default
is set to use 4800 bits/second baud rate.

Data Bits Specifies the number of bits in the bytes transmitted and received. The default is
set to use 8 hits byte size.

Parity Specifies the parity scheme to be used. The default is set to use No Parity
scheme.

Stop Bits Specifies the number of stop bits to be used. The default is set to use one stop
bit.

Flow Control Not used

Select NMEA Specifies GPS sentence types to be used. The default is set to RMC.

Sentences

GPS Output Time

Specifies rate at which GPS data is output to the PC. This value must be set to
match actual GPS settings (The Imagenex GPS is preset to 1 second).

Satellites in Use

GPS Quality / This diagnostic value is read from the GPS receiver and provides the quality of
Status received GPS data.
Number of This diagnostic value is read from the GPS receiver and provides the number of

satellites the GPS has found.

Note. “GPS Quality / Status” and “Number of Satellites in Use” values are dependant on the selected

NMEA sentence:

GPS Quality / Status => GGA => 0 = Fix not available, 1 = Non-differential fix available.

GLL => 0 = Fix not available, 1 = Non-differential fix available.
RMC => A = Valid position, V = NAV receiver warning.

Number of Satellites in Use => GGA=>0-12

GLL => Not available.
RMC => Not available.

The Baud Rate, Data Bits, Parity, and Stop Bits should match those in the GPS receiver specifications.
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GPS Serial Port Configuration and Diagnostics

Fort Settings

Com Port: COM1 v] Farity: ‘Ngne v] m
_ance
Baud Rate:  [4.600 v] Stop Bits: “I v]

Default
Data Bits: a v] Flowe Contral:  |Mane v]

Select NMEA Sentences  |RMC - GPS Output Tirme {1000 ﬂ msec

~ Diagnotics -
GRS Quality / Status: Jn,ﬂ'a Mumber of Satellites in Use: ]U

GFE Sentences Received:

Figure 10 - GPS Serial Port configuration Dialog Box
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Appendix A — Target Height Calculation

Target Height Calculation
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Figure 11 - Target Height Calculation
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Appendix B — External Resources

The YellowFin Sonar System provides several aids for post processing and/or controlling sonar data.
When recording a file, one may choose to record the data in an “.xtf” or “.872” format. YellowFin.exe is
able to playback an “.xtf” file that was recorded using YellowFin.exe. Also, Data from a “.872" or an “.xtf”
file may be “copied” to an .xtf file using the Copy Start and Copy Stop commands in the File Menu.

Once the “.xtf” file is generated, post processing may be done on this file. The following companies
provide post processing software packages:

» Chesapeake Technology, Inc. (http://www.chesapeaketech.com)
» HYPACK inc. (http://www.hypack.com)

e Quality Positioning Services (http://www.gps.nl)

e CARIS (http://www.caris.com)
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When recording the YellowFin data to a .872 file, the following bytes are appended and saved to the file
every ping. The total number of bytes ‘N’ for each ping is equal to 4096.

Byte # Byte Description
0-999 File Header (1000 bytes)
1000-1999 Port Channel Echo Data (1000 bytes)
2000-2999 Starboard Channel Echo Data (1000 bytes)
3000-3nnn GPS Strings (100 bytes/string)
3nnn-4093 Zero Fill
Pointer To Previous Ping
The last 2 bytes of this ping contain a 16-Bit number that is the sum of the
4094-4095 number of bytes for this ping and the number of bytes for the previous ping.
This number can be used for reverse playback synchronization.
Number of bytes to previous ping = ((Byte 4094)<<8) | (Byte 4095)
FILE HEADER

Bytes 0 through

999 contain the following File Header information:

Byte 0 ASCII '8’

Byte 1 ASCII 7!

Byte 2 ASCII '2'

Byte 3 872 File Version
0 = v1.xx — 1000 points/channel, 8-Bit data

Bytes 4-7 Ping Number - increment for every ping
Byte 4 Byte 5 Byte 6 Byte 7
7-0 7-0 7-0 7-0
Ping Number

Bytes 8-9 Total Bytes ‘N’ - number of bytes that are written to the disk for
Byte 8 Byte 9
7]6]5]4]3]2]1]o]7]|6]5[4]3]2]1]0
N = 4096

this ping
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Bytes 10-11

Byte 12

Byte 13

Byte 14

Bytes 15-16

Bytes 17-18

Bytes 19-30

Data Points Per Channel

Byte 10 Byte 11
7]l6|5]a]3[2]1]o|7]6][5]4a]3][2]1]0
1000

Bytes Per Data Point
always 1

Data Point Bit Depth
always 8

GPS Type/ Number of GPS Strings

GPS Type indicates which NMEA 0183 message was selected by the user and used for
decoding Lat/Lng coordinates. Number of GPS Strings indicates how many GPS strings
were detected and stored. Each string is stored (in ASCII) exactly as it appeared at the
serial communications port during real-time data acquisition. The strings are stored in a
100 byte slots starting at GPS String File Offset (Bytes 15-16).

Byte 14

7 | 6 | 5 | 4 3 [ 2 [ 1 [0
GPS Type Number of GPS Strings
GPS Type:

0 > $GPGLL

1> $GPGGA

2 > $GPRMC

NMEA 0183 GPS Strings stored at the following offse  ts:
$GPGLL: stored at GPS String File Offset + 0
$GPGGA: stored at GPS String File Offset + 100
$GPRMC: stored at GPS String File Offset + 200
$GPVTG: stored at GPS String File Offset + 300

GPS String File Offset

Byte 15 Byte 16

7]l6|5]a]3[2]1]o|7]6][5]4a]3][2]1]0

Offset = 3000

Event/Annotation Counter

Byte 17 Byte 18

7]l6|5]a]3[2]1]o|7]6][5]4a]3][2]1]0

E | Count: 0to 32767

E =0, no event, ignore count

E = 1, new event, increment count and append annotation file
Annotations are stored in “filename.an”

Each annotation contains a maximum of 512 characters.

Date — system date, null terminated string (12 bytes)
"DD-MMM-YYYY"
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Bytes 31-39

Bytes 40-44

Byte 45

Byte 46

Byte 47

Byte 48

Bytes 49-50

Bytes 51-52

Bytes 53-65

Bytes 66-69

Byte 70

Model 872 ver 2.0 User’'s Manual

Time — system time, null terminated string (9 bytes)
"HH:MM:SS*"

Thousandths of Seconds
"ttt

— system time, null terminated string (5 bytes)

Operating Frequency
0 = Low Frequency

1 = Medium Frequency
2 = High Frequency

Range Index —index numbers for acoustic operating range
5-10m

6 - 20m
7-30m

8 - 40m
9-50m
10 - 60m
11 -80m
12 - 100m
13-125m
14 - 150m
15 -200m

Data Gain
YellowFin - 0 to 100
YellowFin AUV - 0 to 40

Channel Balance

0 to 60 - +/-3dB in 0.1dB increments
0 = +3dB Port / -3dB Stbd

30 = 0dB for both channels

60 = -3dB Port / +3dB Stbd

Repetition Rate — Time between pings

Byte 49 Byte 50

7]l6|5]4a]3[2]1]of7]6|5[4]3][2]1]0

Repetition Rate (ms)

Sound Velocity

Byte 51 Byte 52

7]l6|5]4a]3[2]1]of7]6|5[4]3][2]1]0

Sound Velocity (in meters/second) * 10

12 Byte File Header . Refer to the section “Interface Return Data” in the document
“YellowFin Ethernet Specification” for further details.

Reserved - always 0
Sonar Type

0 — YellowFin
1 - YellowFin AUV
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Byte 71

Bytes 72-999

Bytes 1000-1999

Bytes 2000-2999

Bytes 3000-3nnn
Bytes 3nnn-4093

Bytes 4094-4095

Real Range
10, 20, 30, 40, 50, 60, 80, 100, 150, 200

Reserved
always 0

Port Channel Echo Data

1000 data points (1 byte/point)

first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 — 255

Starboard Channel Echo Data

1000 data points (1 byte/point)

first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 — 255

GPS Strings — (100 bytes/string)

Zero Fill

Pointer to Previous Ping

Byte 4094 Byte 4095

7]l6|5]a]3[2]1]o|7]6][5]4a]3][2]1]0

Number of bytes to previous ping = 8192

Model 872 ver 2.0 User’'s Manual
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Appendix D — Annotation File Format (.AN)

The .AN File is generated / updated whenever an event marker is created. It is an ASCII text file which
contains pointers to the location in the .872 file where the event occurs. It also contains the GPS
coordinates, date and time, and user entered text. Refer to page 12 for details on event marker creation.

Note: The “.AN” annotation file is linked to the “.872" data file. Do not rename one file without
‘ renaming the other. Do not edit the “.AN” file. Failure to comply will result in errors, and/or lost
I event markers.

ID Number - 0-99
Ping number — Ping number in the .872 file that this event is referenced to.
X-coordinate ratio - Location of the event in the current ping.
Date — System date, null terminated string (12 bytes)
"DD-MMM-YYYY"

Time — System time, null terminated string (9 bytes)
"HH:MM:SS*"

GPS Ships Position Latitude — text string (14 bytes)
“dd.mm.xxxxx_N "
dd = Degrees
mm = Minutes
xxxxx = Decimal Minutes
_ = Space
N = North or S = South

GPS Ships Position Longitude  — text string (14 bytes)
“ddd.mm.xxxxx_E "
ddd = Degrees
mm = Minutes
xxxxx = Decimal Minutes
_ = Space
E = East or W = West

User comment — 512bytes
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Appendix E — Ethernet Interface Specification (V1.0 1)

OVERVIEW

The Interface Board (160-017.V3) communicates via an Ethernet connection to Windows™ based PC.
The PC software needs to know the IP address and the correct port number of the sonar in order to create
a socket. If a direct Ethernet connection is used, then the PC’s Ethernet card must have a statically
assigned IP and Subnet Mask matching that of the sonar. If running through a local area net work, then
the PC’s Ethernet card may have dynamically allocated IP but the sonar’s IP address MUST be
reassigned to that matching the LAN.

To interrogate the underwater unit and receive echo data, a “Switch Data Command” string is sent to the
interface board, which, in turn, translates the data and sends “Sonar Control Commands” to the
underwater unit. When the Sonar Control Command is accepted, the sonar transmits, receives, and sends
its return data back up to the interface board. The interface board then packages the received data and
sends it back to the PC which, in turn, processes and plots the data.

To receive one sonar shot of acoustic data:

1. Send a TCP packet containing the Switch Data Command (with byte 18: Packet =
0x00).

2. Receive a TCP packet containing the Port channel’s data.

3. Send a TCP packet containing the Switch Data Command (with byte 18: Packet =
0x02).

4. Receive a TCP packet containing the Starboard channel’'s data.

The Interface Return Data is the same for Port and Starboard returns. However, the packet number and
actual data reflect the different channels.
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SWITCH DATA COMMAND (PC to Interface Board)

The interface board accepts up to 27 bytes of switch data from the PC and must see the “Switch Data
Header” (2 bytes: OXFE and 0x44 hexadecimal) in order to process the switches. The interface board will
stop accepting switch data when it sees the termination byte (OxFD HEX). The termination byte must be

present for the interface board to process the switches.

Note: the Termination Byte is the only switch value allowed to have a
value of OxXFD. All other switches should be set hig her or lower than OxFD
(253 Decimal) so they are not interpreted as a term  ination byte!

Table 1 - Switch Data Command To 160-017.v1 Interface board

Byte # Description
0-7 OxFE 0x44 |Reserved| Range Reserved |[Reserve| Master/ [Mode/Freq
d Slave
8-15 Data |Reserved| Balance | Reserved | Reserved Link [Reserve|Reserved
Gain Gain Comman d
d
16 — 23 |Reserved|Reserved| TCP Reserved | Reserved |Reserve|Reserve|Reserved
Packet d d
24 — 26 |Reserved|Reserved| Term.
0xFD

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unless noted with a 'Ox' (hexadecimal) prefix.

Byte 0 Switch Data Header (1st Byte)
Always OxFE (254 decimal)
Byte 1 Switch Data Header (2nd Byte)
Always 0x44 (68 decimal)
Byte 2 Reserved
0
Byte 3 Range
0x05 — OxOF
Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m
Byte 4 Reserved
0
Byte 5 Reserved
0
Byte 6 Master/Slave

Not used (0x43)

Byte 7 Mode / Frequency
0. Low Frequency
1. Medium Frequency
2. High Frequency
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Byte 8 Data Gain
0 — 100%
Byte 9 Reserved
0
Byte 10 Balance Gain
Integer values 0 through 60 decimal generates a matched gain balance in .1db
increments.
. x—30
Starboard gain (dB) = ————
10
Port gain (dB) = 30-X
10
Example x = 42
42 -30
Starboard gain (dB) = ——— =1.2dB
10
30-42
Port gain (dB) = ——— =-1.2dB
10
Byte 11 Reserved
0
Byte 12 Reserved
0

Byte 13 Link Command (3 bits)
Down Telemetry value to YellowFin head

000 Standard Sonar Shot
001 Set Mode / Freq

010 Set Range

011 Set Gain Bal

100 Reserved

101 Reserved

110 Reserved

111 Link to Link

Byte 14 Reserved
0

Byte 15 Reserved
0

Byte 16 Reserved
0

Byte 17 Reserved
0
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Byte 18

Byte 19

Byte 20

Byte 21

Byte 22

Byte 23

Byte 24

Byte 25

Byte 26

TCP Packet Number (3 bits)

Model 872 ver 2.0 User’'s Manual

Indicates which TCP formatted packet is requested from the PC. The Sonar shot is
initiated on receipt of TCP Packet number = 0x00. Data is collected for both Port and
Starboard channels. Port data is then sent to the PC. On receipt of 0x02, Starboard Data

(which is already collected) is sent to the PC.

0x00 - Initiate Sonar Shot and return first TCP packet (Port data)
0x01 - Reserved

0x02 - Return second TCP packet (Starboard data)

0x03 - Reserved

0x04 -> 0x07 - Reserved

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Termination Byte
The Interface board will stop looking for Switch Data when it sees this byte.
Always OxFD (253 decimal)
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INTERFACE RETURN DATA

After every shot, the interface board returns a 12 byte header, 1000 points of echo data, and a

terminating byte value of OxFC. The total number of bytes

(N), including the 12 byte header, returned

will be 1013.

Table 2 — YellowFin Return Data From 160-017.v3 Interface board to PC

Byte # Description
Oto7 ASCII ASCII ASCII Serial | Sync byte [Sync byte| Sync | Sync byte
' 'G' X' Status (LO) byte (Hh
8to 11 | SyncVal [Sync Val| Data Data
(LO) (HI) |Bytes (HI)| Bytes
(LO)
12 to Echo Data
(N-2) 1000 Data Bytes
N-1 Term.
OxFC

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unless noted with a 'Ox' (hexadecimal) prefix.
N = total number of return bytes
Byte 0 - 2 Imagenex Return Data Header
ASCII'IGX'
'I'=0x49, 'G' = 0x47, 'X' = 0x58
ASCII'IGX'
N = 1013, (1000 Data Bytes, 12 header bytes, 1 termination byte)
Byte 3 Serial Status
Bit 7 Bit 6 Bit5 | Bit4 | Bit3 Bit 2 Bit 1 | Bit0
1= 1 = Switches 0 0 0 Channel
Character | Accepted
Overrun
1 = Switch 0 0 |Port
Error
0 1 [Reserved
1 0 [Starboard
1 1 [Reserved
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Byte 4-7 Sync message bytes

Byte 4 Byte 5 Byte 6 Byte 7
716|5]4[3]2]1]0][7]6]|5[4]3]2]1]0|7]6]5]4]3][2]1]0][7][6]5]4[3]2]1]0

0] 0| Sync Message 0|0 SyncMessage |0| 0| SyncMessage |0| 0] Sync Messages
(LO) (H)

YellowFin Sync messages: 23 bits

YellowFin Sync messages:

(byte [4] & Ox3F) | (byte [5]<<6 & OXOFFF) | (byte [6]<<12 & Ox3FFFF) | (byte
[7]<<18&0x7FFFFF)

Sync Messages:

Sync Word:
2221201918 [17]16 1514|1312 |11 [10]9]8|7[6]5[4][3[2]1] 0O
1]11]0]0 Reserved (0's) Information Run Type il

Bits 22-21.: Trigger (11)

Bits 20-19: Head ID (00)

Bit 0: Stop bit (1)

Bits 4-1: Run Type (Echo’s Link Control Bits)

(0000) Sonar data
(0001) Mode / Freq
(0010) Range
(0011) Gain Balance
(0100) Reserved
(0101) Reserved
(0110) Reserved

Bits 12-5: Information

If Run Type =0 or Run Type =2
Range Index :
0x05 through Ox0F
Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m

If Run Type =1
Mode / Frequency :
0x00 through 0x02
0. Low Frequency
1. Medium Frequency
2. High Frequency

If Run Type =3
Gain Balance :
Integers 0 through 60
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Bits 18-13: Reserved
Byte 8,9 Sync Value
Byte 8 Byte 9
7l6[5]4|3[2]1]0o]l7] 6 [5]4[3][2]1]0
0 Sync Value (LO) 0 |Rx | Sync Value (HI) L

Sync value is used for diagnostics (normal sync value is around 800).

Sync Value Byte (LO), Sync Value Byte (HI)

Sync Value Byte (LO)= (Byte 9 & 0x01)<<7 | (Byte 8 & Ox7F)
Sync Value Byte (HI)= (Byte 9 & Ox3E)>>1;

Sync Value = (Sync Value Byte (HI)<<8) | Sync Value Byte (LO)

No_RX_Data = Byte 9&0x40

If No_RX_Data = 1, low or no sync value
If No_RX_Data = 0, normal sync value

Byte 10,11 Number of data bytes

Number of Echo Data Bytes returned
Data Bytes (LO), Data Bytes (HI)

Byte 10

Byte 11

7l6|[5]4a|3[2]1]of7]6]5]4]3][2]1]0

Data Bytes (HI) Data Bytes (LO)

Data Bytes = (Data Bytes High Byte<<8) | Data Bytes Low Byte

Byte 12 Start of Echo Data
(N-12) Bytes of data

1st Range Point = Byte 12
2nd Range Point = Byte 13
3rd Range Point = Byte 14
4th Range Point = Byte 15
etc. ...

Byte (N-2) End of Echo Data

Byte (N-1) Termination Byte
OxFC
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Solder View
5PIN MS

SHLD

C1

c2

5PIN MS

Part Number
54-020421-04

(Keviar, Yellow Shielded)

Subconn MCIL4F
G

C1

c2

Socket View

IMAGENEX TECHNOLOGY CORP.

Title: YellowFin Tow Cable

Document Number: 872-200-168 ‘ oy

Date:  Oct 19, 2004 Sheet 1 of 1

Figure 12 - YellowFin Tow Cable Wiring Diagram
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Introduction

The Imagenex Model 872 YellowFin side scan sonstesy consists of an underwater sonar head
connected via analogue telemetry directly to asgrinterface processor. This processor contains
the necessary power to run the underwater unitjlaib differential capable GPS unit, and an
Ethernet enabled interface board.

This document covers the necessary setup procetiueesble your WindowsXP® based PC to

communicate with the processor.

Ethernet Cable
The included Ethernet cable specifications are:

« Catb5e
* RJ-45
» 568B wiring scheme

If this cable needs to be replaced, ensure thatallove specifications are met.

Updated on April 21, 2008 Page 2 of 9
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Configuration of Windows XP Ethernet Communications

For the YellowFin System, the following Addresste ased

PC

IP Address

192.168.0.X

Subnet Mask

255.255.255

0

Where ‘X' is a decimal number between 3 and 254 nbmber ‘1’ is reserved for a network
server, ‘255’ is reserved for a network broadcasssage, and ‘2’ is reserved for the YellowFin

processor.

The YellowFin processor has a statically assigiedddress 01192.168.0.2 This is the
number to enter in the Connection Dialog Box asnshim Figure 3

The Recommended PC'’s IP address and Subnet Masle $1C are:

IP Address

192.168.0.3

Subnet Mask

255.255.255

On a Window€ XP® based machine, this is done as follows:

0

1. Navigate the Control Panel and double click “NetwGonnections”
2. Right click on the Ethernet interface you wish émeect with and select “Properties”

Updated on April 21, 2008
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4L ocal Area Connection Prg 2| x|

Gieneral | futhentication | Advanced |

Connect using:

I B4 Realtek RTLE133/810x Family Fast Ethemet NIC

Thiz connection uses the fallowing itens:

% Client for Microzoft Netwaorks
g File and Printer Sharing for Microsoft Mebworks
g Qo5 Packet Scheduler

Install... | 1 rrstal| Propertiesz

 Description

Transmiszion Control Protocal/Internet Protocal, The default
wide area network, protocol that provides communication
across diverze interconnected nebwarks.

¥ Show icon in notification area when connected

Ok, | Cancel |

Figure 1 - Local Area Connection Properties Dialodgox
3. Select Internet Protocol (TCP/IP) and select “Pripg’

Internet Protocol (TCP/IP) Pro 2x]

General |

You can get IP zettings azsigned automatically if wour network. supparts
thiz capability, Othemsize, you need to ask your nebwork, administrator for
the appropriate [P settings.

" Obtain an IP address automatically

—% Use the following IP address:
IP address: 192 168 . 0 . 3

Subnet mask: I 2BE 255 255 O
Default gateway: I . . .

€ btain DME senver address automatically

— Use the following DMS server addresses:

Preferred DMS server I . . .
Alternate DS server: I . . .

Advanced... |
agK I Cancel |

Figure 2 - TCP/IP Priorities Dialog Box

4. Enter the information shown above in Figure 2 ditk ¢OK” to accept the changes.
5. Click “OK” again to accept the changes.
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Now your computer is on the samdetwork” as the Processor. When starting the YellowFin.exe
program, a dialog box as shown below in Figure IBapipear asking for the IP Address. Enter
theProcessor'dP AddressNOT the PC’s address. (Note: The current IP Addresaved in

the “YellowFin.cfg” file located in the programsatofolder)

Connection

P address: 19216802

Figure 3 - YellowFin.exe Connection Dialog Box

| The processor has a statically assigned IP Adafes32.168.0.2 Enter this number in the Connection Dialog Bt{Jx.
The system will run fine. However, if communicatitanthe head does not function properly, try
these suggestions.

1. Disable any network bridges that are present
* A network bridge allows a separate port, such &BU) or “Firewire” to piggyback
the Ethernet connection.
» Under “Network Connectiorisif there is a network bridge icon, disable it.

Under “Network Connections”, right-click on the Ethet card and select properties.

2. Clear unnecessary network protocols
* De-select all services except fanternet Protocol (TCP/IP)”

3. Remove any firewalls present (Note that Window$XP® has a rudimentary firewall
built into it. Disable this one first).
» Select the “Advancédrab. De-select the Firewall option (if present).

Click on “Configure” (in the “General” tab) and aw dialog box will appear.

4. Set Link speed to “Auto” or “10Mbps”
* Inthe “Advancetitab, select “Link Speed / Duplex Mode” and setither ‘Auto
Mode’ or “10 Full Mode”.

5. Disable any power saving that shuts down the Etheet card.

* Inthe "Advanceditab, select “Link Down Power Saving” and set isable’.

Updated on April 21, 2008 Page 5 of 9
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* Inthe “Power Manageméntab, de-select any power saving option.

Sharing an Ethernet Device with the Sonar and Internet

If the computer will be using the same Ethernetldar both the sonar and Internet ue®T

at the same time), set the card for the sonar ukmgbove procedures. When using the Internet,
you will need to reset the IP, Subnet, Default @atg and DNS Server to correspond to your
Internet Service Provider. On most modern systénismay as simple as setting the system to
“Obtain settings Automatically” This will set th@mputer to use the DHCP protocol.

The YellowFin processor has a statically assigfedddress 0192.168.0.2 To re-use the
Sonar system, the above procedW®s$ST be followed
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Appendix A — Setting up a Direct Connection

This is the simplest way to connect to an Imagdfternet Sonar SystefESS) to a computer
(PC) as shown in Figure 4. In this configuration, thex simply a direct connection between the
IESS and the operating PC. Note that the PC httia B> address of “192.168.0.157".

Cat 5e

Sonar Device

IP=192.168.0.2

IP =192.168.0.157

Figure 4 - Connecting the IESS via Direct Connectio
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Appendix B — Setting up a LAN

To connect an Imagenex Ethernet Sonar SystE®S) to a Local Area Network (LAN), refer to
Figure 5. The advantage of this setup is thatE&SI may be operated from any computer that is
connected to the LAN. Note that the server compuast be running WindoWsxP® PRO in

order to set up a LAN. This is because only’ RO contains the necessary DHCP server
component to auto-configure the client PC’s. Theesealso has a static IP address of
“192.168.0.1” and no other PC on the network maxefthis IP. Currently, the IESS does not
support DHCP and is simply “piggy-backing” the netiwby using an IP that is on the same
Subnet Mask as the LAN.

Server

IP=192.168.0.1

4

il
HII Cat 5e
7

‘ HUB I:II_‘—_II:I:I‘

Cat 5e

Cat 5e

Cat5

Sonar Device

IP =192.168.0.2

IP =192.168.0.144 IP =192.168.0.157

Figure 5 - Connecting the IESS via a LAN
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Appendix C — Setting up a Networked LAN

To connect an Imagenex Ethernet Sonar SystE®S) to a networked Local Area Network
(LAN), refer to Figure 6. This setup consists 0btlhAN'’s interconnected via a router. The
router acts as a server to the LAN that is directignected to the IESS. The advantage of this
setup is that the IESS may be operated from anyatenthat is connected to either LAN. The
server has a static IP address of (for example2.1&7.0.1". The router essentially has to sides.
One side is configured as a client (“172.16.0.12#1) the other side is configured as a server
(“192.168.0.1"). Currently, the IESS does not suppdHCP and is simply “piggy-backing” the
network by using an IP that is on the same Subrastiki\as the LAN.

Server

IP=172.16.0.1

Cat 5e

Cat 5e ‘

Cat 5e

172.16.0.127

Route@ BRI ] (e
192.168.0.1

IP=172.16.0.13 IP=172.16.0.45

Cat 5e Cat 5e

Sonar Device

IP =192.168.0.2

IP =192.168.0.157

Figure 6 - Connecting the IESS through a multiple IAN

Updated on April 21, 2008 Page 9 of 9
C:\Documents and Settings\Owner\My Documents\Pts\¥ellowFin\Documentation\YellowFin Ethernet Set@pide.doc



IMAGENEX TECHNOLOGY CORP.

MODEL 872 SIDESCAN
(YellowFin)

ETHERNET INTERFACE SPECIFICATION (v1.01)

Document Number | 425-025

Revision Date Description
00 August 19, 2004 Initial
01 October 22, 2009 Added Version number

Specifications subject to change without notice



Imagenex Technology Cor@2009 YellowFin Ethernet Interface Specification (v1.01)

OVERVIEW

The Interface Board (160-017.V3) communicates wi&thernet connection to WindoWsased PC. The PC
software needs to know the IP address and theatgroet number of the sonar in order to createckeid If a direct
Ethernet connection is used, then the PC’s Ethearet must have a statically assigned IP and SuMask
matching that of the sonar. If running through @alcarea net work, then the PC’s Ethernet card maag
dynamically allocated IP but the sonar’s IP addMEEST be reassigned to that matching the LAN.

To interrogate the underwater unit and receive el&dta, a “Switch Data Command” string is sent wittierface
board, which, in turn, translates the data and s&8dnar Control Commands” to the underwater Mihien the
Sonar Control Command is accepted, the sonar titg)geceives and sends its return data back tipetonterface
board. The interface board then packages the mteiata and sends it back to the PC which, in finetgesses and
plots the data.
To receive one sonar shot of acoustic data:

1. Send a TCP packet containing the Switch Data Cordnfaith byte 18Packet = 0x00).

2. Receive a TCP packet containing the Port chandata.

3. Send a TCP packet containing the Switch Data Cordri\aith byte 18Packet = 0x02).

4. Receive a TCP packet containing the Starboard @farohata.

The Interface Return Data is the same for PortStadboard returns. However, the packet number andladata
reflect the different channels.

Document Number: 425-025-01 Page 1 of 7
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SWITCH DATA COMMAND (PC to Interface Board)

The interface board accepts up to 27 bytes of svdita from the PC and must see the “Switch Datedelg (2
bytes:0xFE and0x44 hexadecimal) in order to process the switches.iftleeface board will stop accepting switch
data when it sees the termination byieHD HEX). The termination byte must be present forittterface board to
process the switches.

Note: the Termination Byte is the only switch valuallowed to have a value of
OxFD. All other switches should be set higher or l@er than 0xFD (253 Decimal) so
they are not interpreted as a termination byte!

Table 1 - Switch Data Command To 160-017.v3 Interfze board

Byte # Description
0-7 OxFE 0x44 Reserved Range Reserved | Reserved Master/| Mode/Freq
Slave
8-15 Data Gain| Reserveql Balance GairReserved Reserved Link | Reserved Reserved
Command
16 -23 Reserved Reserved  TCP Pagket Resenjed vBaser | Reserved Reserved Reservefd
24 - 26 Reserved Reserved Term,
0xFD

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unlested with a '0x' (hexadecimal) prefix.

Byte O

Byte 1

Byte 2

Byte 3

Byte 4

Byte 5

Byte 6

Byte 7

Byte 8

Switch Data Header (1st Byte)
AlwaysOxFE (254 decimal)

Switch Data Header (2nd Byte)
Always0x44 (68 decimal)

Reserved
0

Range
0x05 — OxOF
Operating range: 10, 20, 30, 40, 50, 60, 80, 128, 150, 200m

Reserved
0

Reserved
0

Master/Slave
Not used (0x43)

Mode / Frequency

0. Low Frequency

1. Medium Frequency
2. High Frequency

Data Gain
0 — 100%
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Byte 9

Byte 10

Byte 11

Byte 12

Byte 13

Byte 14

Byte 15

Byte 16

Byte 17

Reserved

0

Balance Gain

Integer values 0 through 60 decimal generates ahmdtgain balance in .1db increments.

x—-30
Starboard gain (dB) =
gain (dB) 10
30-x
Port gain (dB) =
gain (dB) 10

Example x = 42

Starboard gain (dB) :421;(]30 =1.2dB

Port gain (dB) :M =-12dB

1C

Reserved
0
Reserved
0

Link Command (3 bits)
Down Telemetry value to YellowFin head

000 Standard Sonar Shot
001 Set Mode / Frequency
010 Set Range

011 Set Gain Balance

100 Reserved

101 Reserved

110 Reserved

111 Link to Link

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Document Number: 425-025-01
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Byte 18 TCP Packet Number (3 bits)

Byte 19

Byte 20

Byte 21

Byte 22

Byte 23

Byte 24

Byte 25

Byte 26

Indicates which TCP formatted packet is requeBtan the PC. The Sonar shot is initiated on
receipt of TCP Packet number = 0x00. Data is ctdlbfor both Port and Starboard channels. Port
data is then sent to the PC. On receipt of OxC&pb®ard Data (which is already collected) is sent
to the PC.

0x00 - Initiate Sonar Shot and return first T@ket (Port data)
0x01 - Reserved

0x02 - Return second TCP packet (Starboard data)

0x03 - Reserved

0x04 -> 0x07 - Reserved

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Reserved
0

Termination Byte
The Interface board will stop looking for SwitBlata when it sees this byte.
AlwaysOxFD (253 decimal)
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INTERFACE RETURN DATA

After every shot, the interface board returns &ylt2 header, 1000 points of echo data, atetrainating byte
value ofOXFC. Thetotal number of bytes(N), including the 12 byte header, returned will 1043

Table 2 — YellowFin Return Data From 160-017.v3 Irgrface board to PC

Byte # Description

Oto7 ASCII ASCII ASCII Serial | Sync byte [Sync byte Sync | Sync byte

' 'G' X' Status (LO) byte (HI)
8to 11| Sync Val | Sync Val|Data Byte|Data Bytes
(LO) (H) (HD) (LO)

12 to Echo Data

(N-2) 1000 Data Bytes

N-1 Term.

OxFC

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unless natéti a '0x' (hexadecimal) prefix.
N = total number of return bytes

Byte 0 -2 Imagenex Return Data Header
ASCII 1GX"
"= 0x49, 'G' = 0x47, 'X' = 0x58
ASCII 1GX"
N = 1013, (1000 Data Bytes, 12 header bytestritation byte)
Byte 3 Serial Status
Bit 7 Bit 6 Bit 5| Bit4 | Bit3 Bit 2 Bit 1| Bit 0
1 = Character |1 = Switches| 0 0 0 0 Channel
Overrun Accepted
1 = Switch 0 0 Port
Error
0 1 Reserved
1 0 Starboard
1 1 Reserved
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Byte 4-7 Sync message bytes

Byte 4 Byte 5 Byte 6 Byte 7
716|5|4[3]2|1]0]|7]|6|5[4]|3]|2][1]0|7|6]|5]4][3][2]1]0][7][6]|5]/4[3]2]1]0
0 0 Sync Message | 0| Of Sync Message 00 Sync Message 00| Sync Messages
(LO) (HN)

YellowFin Sync messages: 23 bits

YellowFin Sync messages:

(byte [4] & Ox3F) | (byte [5]<<6 & OXOFFF) | (by[6]<<12 & OX3FFFF) | (byte
[7]<<18&0x7FFFFF)

Sync Messages:

Sync Word:

22| 21| 20| 19 18 17 16 15 M 13 12 fp1 J1o| 9| 8] 7| 6] 534 2| 1] 0

1 1 0] O Firmware Version Information Run Type 1

Bits 22-21: Trigger (11)
Bits 20-19: Head ID (00)

Bits 18-13: Firmware Version
6 bit integer number for diagnostic purposes

Bits 12-5: Information

If Run Type = 0 or Run Type= 2
Range Index
0x05 through 0x0F
Operating range: 10, 20, 30, 40, 50, 60, 80, 108, 150, 200m

If Run Type=1
Mode / Freguency
0x00 through 0x02
0. Low Frequency
1. Medium Frequency
2. High Frequency

If Run Type= 3
Gain Balance
Integers 0 through 60

Bits 4-1: Run Type (Echo’s Link Control Bits)

(0000) Sonar data

(0001) Mode / Frequency
(0010) Range

(0011) Gain Balance
(0100) Reserved

(0101) Reserved

(0110) Reserved

Bit O: Stop bit (1)

Document Number: 425-025-01 Page 6 of 7



Imagenex Technology Cor@2009

YellowFin Ethernet Interface Specification (v1.01)

Byte 8,9 Sync Value

Byte 8 Byte 9
7]16[5] 4/ 3 211 g 417 6] 5 4 B p I
0 Sync Value (LO) 0] Rx Sync Value (HI) L

Sync value is used for diagnostics (normal syalae is around 800).

Sync Value Byte (LO), Sync Value Byte (HI)

Sync Value Byte (LO)= (Byte 9 & 0x01)<<7 | (By@8eX 0x7F)

Sync Value Byte (HI)= (Byte 9 & Ox3E)>>1;

Sync Value = (Sync Value Byte (HI)<<8) | Synalie Byte (LO)

No_RX_Data = Byte 9&0x40
If No_RX_Data =1, low or no sync value
If No_RX_Data = 0, normal sync value

Byte 10,11 Number of data bytes
Number of Echo Data Bytes returned
Data Bytes (LO), Data Bytes (HI)
Byte 10 Byte 11
7]6]s5]4]3[2[ 3 of 7 4 % 4 B P [
Data Bytes (HI) Data Bytes (LO)
Data Bytes = (Data Bytes High Byte<<8) | DataeBytow Byte
Byte 12 Start of Echo Data
(N-12) Bytes of data
1st Range Point = Byte 12
2nd Range Point = Byte 13
3rd Range Point = Byte 14
4th Range Point = Byte 15
etc. ...
Byte (N-2) End of Echo Data
Byte (N-1) Termination Byte

OxFC

Document Number: 425-025-01

Page 7 of 7



Imagenex Technology Corp.

September 14, 2006

IMAGENEX YELLOWEFIN SIDESCAN SONAR

PULSE REPETITION RATES

RANGE REP-RATE
Meters ms (Hz)
200 290 (3.4
150 223 (4.5
125 190 (5.3
100 156 (6.4)
80 129 (7.8)
60 102 (9.8)
50 90 (11.1)
40 76 (13.1)
30 63 (15.9)
20 57 (17.5)
10 57 (17.5)

Using YELLOWFIN.EXE v1.09c, Pentium 4 (2.8 GHz), Windows XP



IMAGENEX TECHNOLOGY CORP.

MODEL 872 SIDESCAN
(YellowFin)

DATA STORAGE FILE FORMAT (v1.01)
(.872)

Document Number | 425-026
Revision Date Description
00 May 14, 2007 Initial
01 October 22, 2009 Reformatted
02 January 21, 2011 Added Altitude to bytes 65-68

Specifications subject to change without notice
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Yellowfint®&torage File Format (.872)

OVERVIEW

When recording the YellowFin data to8¥2file, the following bytes are appended and saweithé file every ping. The total
number of bytesN’ for each ping is equal 4096

Byte # Byte Description
0-999 File Header (1000 bytes)
1000-1999 Port Channel Echo Data(1000 bytes)
2000-2999 Starboard Channel Echo Data(1000 bytes)
3000-3nnn GPS Strings(100 bytes/string)
3nnn-4093 Zero Fill
Pointer To Previous Ping
The last 2 bytes of this ping contain a 16-Bit nemthat is the sum of the numbg
4094-4095 of bytes for this ping and the number of bytestfar previous ping. This number
can be used for reverse playback synchronization.
Number of bytes to previous ping = ((Byte 4094)<k@yte 4095)
FILE HEADER

Bytes 0 through 999 contain the followiRge Headerinformation:

(=)

Byte 0 ASCII '8'
Byte 1 ASCII'7!
Byte 2 ASCII '2'
Byte 3 872 File Version
0 = v1.xx — 1000 points/channel, 8-Bit data
Bytes 4-7 Ping Number — increment for every ping
Byte 4 Byte 5 Byte 6 Byte 7
7-0 7-0 7-0 7-0
Ping Number
Bytes 8-9 Total Bytes ‘N’ - number of bytes that are written to the disktfos
Byte 8 Byte 9
7]6]5[4[ 3] 2] 1] of 7[ 6 § 4 3 2 1}
N = 4096
Bytes 10-11 Data Points Per Channel
Byte 10 Byte 11
7]6]5[4[ 3] 2] 1] of 7] 6 § 4 3 2 1
1000
Byte 12 Bytes Per Data Point
always 1
Byte 13 Data Point Bit Depth
always 8

ing

Document Number: 425-026-02

Page 1 of 3



Imagenex Technology Corp. ©2009 Yellowfint®&torage File Format (.872)

Byte 14

Bytes 15-16

Bytes 17-18

Bytes 19-30

Bytes 31-39

Bytes 40-44

Byte 45

GPS Type/ Number of GPS Strings

GPS Type indicates which NMEA 0183 message wasteeldy the user and used for decoding Lat/Lng
coordinates. Number of GPS Strings indicates howyn@PS strings were detected and stored. Eaclystrin
is stored (in ASCII) exactly as it appeared atsbgal communications port during real time data
acquisition. The strings are stored in a 100 blgts starting at GPS String File Offset (Bytes Hj-1

Byte 14
7 | 6 | 5 [ 4 3 [ 2] 171 o
GPS Type Number of GPS Strings
GPS Type
0-> $GPGLL
1-> $GPGGA
2> $GPRMC
NMEA 0183 GPS Strings stored at the following offdse:
$GPGLL: stored at GPS String File Offset + 0
$GPGGA: stored at GPS String File Offset + 100
$GPRMC: stored at GPS String File Offset + 200
$GPVTG: stored at GPS String File Offset + 300

GPS String File Offset

Byte 15 Byte 16

7] 6]s5]af 3] 2] 1] of 7] 6 o 4 ¢ 2 1 D

Offset = 3000

Event/Annotation Counter

Byte 17 Byte 18

v]6]5]4f 3] 2] 1] of 7] 6 § 4 3§ 2 1 D

E Count: 0 to 32767

E =0, no event, ignore count
E =1, new event, increment count and appendtation file.
Annotations are stored in “filename.an”. Eachaation contains a maximum of 512 characters.

Date — system date, null terminated string (12 bytes)
"DD-MMM-YYYY"

Time — system time, null terminated string (9 bytes)
"HH:MM:SS"

Thousandths of Seconds system time, null terminated string (5 bytes)
"t

Operating Frequency
0 = Low Frequency

1 = Medium Frequency
2 = High Frequency

Document Number: 425-026-02 Page 2 of 3



Imagenex Technology Corp. ©2009 Yellowfint®&torage File Format (.872)

Byte 46 Range Index— index numbers for acoustic operating range

5-10m

6 -20m

7 -30m

8 - 40m

9 -50m
10 - 60m
11 -80m
12 - 100m
13-125m
14 - 150m
15 - 200m

Byte 47 Data Gain
0 to 100 percent

Byte 48 Channel Balance
0 to 60> +/-3dB in 0.1dB increments
0 = +3dB Port / -3dB Stbd
30 = 0dB for both channels
60 = -3dB Port / +3dB Stbd

Bytes 49-50 Repetition Rate— Time between pings

Byte 49 Byte 50
7]e[s]af 3] 2] 2] of 7] ¢ § 4 3§ 2 1 D

Repetition Rate (ms)

Bytes 51-52 Sound Velocity

Byte 51 Byte 52
7]e6[s]af 3] 2] 1] of 7] ¢ 9§ 4 3§ 2 1 b

Sound Velocity (in meters/second) * 10

Bytes 53-64 12 Byte File Header. Refer to the eectinterface Return Data” in the document YellowFin Ethernet
Foecification” for further details.

Bytes 65-68 Altitude

4 byte floating point number (in meters)
Bytes 69-999 Reserved- always 0
Bytes 1000-1999 Port Channel Echo Data

1000 data points (1 byte/point)

first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 — 255

Bytes 2000-2999 Starboard Channel Echo Data
1000 data points (1 byte/point)
first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 — 255

Bytes 3000-3nnn GPS Strings— (100 bytes/string)
Bytes 3nnn-4093 Zero Fill
Bytes 4094-4095 Pointer to Previous Ping
Byte 4094 Byte 4095

v]6]5] 4f 3] 2] 1] of 7] 6 o 4 3§ 2 1 D

Number of bytes to previous ping = 8192

Document Number: 425-026-02 Page 3 of 3
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SIDE SCAN USER’S GUIDE

IMAGENEX TECHNOLOGY CORP.
209-1875 Broadway Stireet
Port Coquitlam, B.C., Canada V3C 5W2
tel: 604 944 8248
fax: 604 944 8249

This user’s guide is intended to be a guick reference to the practical use of an
Imagenex towed side scan tish. For more details on sonar theory and the
specific operation of the Model 835 system, see the Model 833 User’s
Manual. If you have any questions about this equipment. please do not

hesilate o call or fax the above noumbers, We are always happy 1o help our
CUSHHTILTS,

Imagenex Side Scan Sonar User’s Guide
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Water surtace 7 ‘“*x\

Shereline LY v ",
Tow fish N \\1
5 T \
|
Starboard Sunken log ‘

(right)

sonar // B":j_n':'m ||

Shors i ! | __. Echa from the

mrE\'”E ! o= water suface (Depth)
b First echao from / X .- Firstecho from
\ the bottam || the bottom {Altilude)

Typical side scan imoge showing o lake boflam near a shoreline, Thea patl ol fhe side scan lowlish
1% dowen the cenlee of the oage. To be left of this vertical Line is the fust echo Tom e waler
surfce, Tha distone Dom e cenlee ling to the echo feom the swcfoce is e depth of e sonn
bealivw e sueface. To e Jeft ol e echo feom the socface s e Gosl echo Goom Uie botton, und
wller Lhe ficst echw Trom the bottom the tmage of i bolloor o the Jel side bepins, The distance
Irumm the cenlee Line o the st cobo Teom dae bBodlorn s Uie albilude ol e sonar abose the bellom.
The surn ol the depth wncd the attitude is the wotal water depth, The strong whike trgaet near the Jeft
edpe of the image s che shore ling, rising o the seclace ol the ke, Large sunken logs ane scactered
over Lhe bottom of this lake,

Explanation of Typical
Side Scan Sonar Image

Tmapgenex Side Scan Sonar User's Guide
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kink & e L
tow cablol \“\Q: TR
M -
T
B
Secure loap
- to suitable cleat Secure tow cable with
— it r 'prusik knot'
— s Thie knot can be moved

\

Loop made from
& mm {1/4 inch}
braided rope

on cable when loose,
sacures cable when tight

e e o

Method to secure tow cable
when no snatch block available

Tow Fish and Tow
Cable Operation

Imagenex Side Scan Sonar User’s Guide
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Secura the polycarbonate tailfins
with nylon cable ties as shown,
Fins must break free if the towtfish
is trapped on bottom. If cable ties
are not available usa strong cord.

Tail Fin Attachment

lower energy

part of

bheam shows

watar surlace
slraight up

horizontal

main sonar beam
vertical 60 degrees
harizontal 1.8

or 0.9 degrees

heam center 20 degreas
below harizantal

lower energy

part of

baam shows

bottom straight down

Sonar Beam Pattern

Imagenex Side Scan Sonar User's Guide
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Tow fishis

too close to the

beottom herel

What The taw fish altitude should be 110 to 210 of the range scale above

Altitude? tha bottam. For example, if you are using the 100 meters range scale,

" the altitude should be 10 o 20 meters. When the bottom is nearly flat,
you can tow close to the battorm, Whan the betlam is not flat, tow al
higher altitude.

Be Careful! There is always a risk that the tow fish will strike the bottom or another
obstacle. This may damaga the low fish, or the fow fish may become
trapped on the bottam. If the fish is trapped on the battom, the tow
cable may break.

Shadows Towing the fish closa to the bottom enhances shadows, and improves
the image details, at the risk af the fow fish hitting the bottom,

Altitude Increasing the speed of the boat increases the alliludea of the fish.
Turning the boat decreases the altituda of the fish. Be caralul when

Control tuming|

Straight & Tao make good side scan images, the tow fish should maove in a smooth

Smooth straight line through the water. Any cscillation in altitude, piteh, rell, or
yaw will introduce distartions into the side scan image.

The ideal speed for towing is about 3 knots, at this speed the vertical
and horizontal scales on the Image are matched approximately.

3 knots

Towing Technigue

Imagenex Side Scan Sonar User’s Guide
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Adjust tow point sa that low fish is horizantal L__
when hanging stationary in the watar

shatch Block
i cm {12 in)

minimum diameater
davil or A-frame ;f

tow fish

YT T T L Y L A T R A R AT YO A A A A

Typical Towing
Arrangement

Imagenex Side Scan Sonar User's Guide
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Imagenex YellowFin® — Side Scan Sonar

ATEN UC-232A RS232 — USB Converter
(Required if no built in serial port available)

To “RS-232 GPS Out” Port
To USB Port 4800, 8,N,1

Ethernet

CAT 5e. Straight

Please refer to Document Number 410-013

“USB Converters and the Windows OS” for important
information on USB <--> RS232 and USB <--> RS485
Converters running on Windows operating systems.

Power
*90-264 Vac
*50/60Hz
«0.75A max

\/

PC Running
YellowFin.exe

' Supported NMEA
i GPS Strings :
. -RMC

*GGL + VTG
GGA + VTG : GPS Antenna

Maximum Depth =300m
(1000"
Maximum Cable Length = 600m
(2000"

YellowFin.exe is supported on:
Windows™ 95, 98, Me, NT, 2000, XP, Vista, 7

Optional DGPS

To “Differential GPS In” Port

4 Conductor Kevlar Cable
Carrying Power and

Telemetry Signals

410-016 rev01
September 21, 2011




Solder View
SPIN MS

SHLD

V+

Cl

C2

SPIN MS
M)

Pin View

Part Number
54-020421-04

(Kevlar, Yellow Shielded)

Subconn MCIL4F
(F)
V-
V+
Cl1
C2

Socket View

IMAGENEX TECHNOLOGY CORP.

Title: YellowFin Tow Cable

Document Number: 872-200-168

Rev
01

Date:  Oct 19,2004 Sheet ] of

1
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